Hieronder volg het concept artikel dat ooit gedacht was om op te laten nemen in het maandblad Electron van de Veron. Zover is het echter (nog) niet gekomen...

Antenne modelering en optimalisatie met (4)Nec2.

Met antenne modellering wordt in dit artikel bedoeld het nabootsen middels een computer programma van de elektrische (HF) eigenschappen van antenne of andere (metalen) structuren.

Bij deze eigenschappen kan b.v. gedacht worden aan het stralingsdiagram, voor-achter verhouding of ingangsimpedantie/staande golf verhouding (SGV) voor een enkele frequentie of voor een bepaalde frequentieband.

Voordat nu geroepen wordt daar heb je weer het zoveelste computer[programma, hierbij toch een kleine nuancering. Ik denk namelijk dat juist doordat je hiermee eenvoudiger kunt voorspellen welke resultaten een bepaald (creatief?) antenne idee zal opleveren zonder dat je hiervoor het dak op, de mast  of de boom in moet, men eerder geneigd is om ook deze ideeën (in elk geval die met goede uitkomsten) in werkelijkheid na te bouwen. Tevens verkleint het de kans om na veel werk tot de ontdekking te komen dat je zojuist in elkaar geknutselde antenne niet of veel slechter werkt dan je gehoopt had en aldus na een aantal experimenten al je zelfbouw enthousiasme vervlogen is.

Wellicht ook dat blad ook niet het medium is om een verhandeling te schrijven hoe een bepaald computerprogramma gebruikt kan worden. Echter omdat e.e.a. zonder bijkomende kosten veel inzicht geeft in de eigenschappen van verschillende antennetypes wil ik toch een uitzondering maken. Daarnaast ben ik van mening dat dit programma minstens gelijke mogelijkheden biedt ten opzichte van de commerciele programma’s zoals b.v Eznec of NecWin+.

In dit artikel zijn twee gedeeltes te onderscheiden. Voor diegenen die het onderste uit de kan willen (automatische optimalizatie, trending e.d.), en daarnaast geïnteresseerd zijn in extra achtergrondinformatie wordt aangeraden om het gehele artikel door te lezen. 

Daarnaast zullen er mensen zijn die zonder veel omhaal direct aan de slag willen en niet perse meer mogelijkheden behoeven dan die welk ook door de commerciele programmas worden geboden. Voor deze zou in principe alleen deel 1 getiteld ‘Schetsmatige model-ingave’ van belang te hoeven zijn. Voor nadere uitleg over hoe antenna-stromen te bekijken en stralings-diagrammen te kunnen genereren wordt aangeraden om ook de paragrafen ‘doorrekenen’ en ‘stralings-diagram’ uit deel 2 door te nemen.

Historie

Door 4nec2 wordt gebruik gemaakt van het rekenprogramma genaamd Nec2.  Dit programma is in de jaren 70 ontwikkeld voor het Amerikaanse ministerie van defensie. In de loop van de jaren zijn er een tweetal opvolgers (Nec3 en Nec4) van dit programma ontwikkeld die, echter alleen beschikbaar waren voor de eigen Amerikaanse markt en dit tegen forse betaling. De programma-code voor het Nec2 programma daarentegen is ‘public domain’, en mag sinds de jaren 90 door eenieder gebruikt worden. Door o.a. de auteur is deze programmacode omgezet naar een uitvoerbaar programma voor een Windows thuis-PC.

Naast Nec2 is er nog een ander programma genaamd Mininec in omloop. Dit programma is reeds in de jaren 80 afgeleid van zijn grotere broer nec2. Daar toendertijd de beschikbare computer- kracht aanzienlijk minder was dan tegenwoordig heeft men e.e.a. moeten vereenvoudigen. Hierop zijn de simulatie programma’s zoals MMANA en AO (antenna optimizer) gebaseerd. Tegenwoordig is dit echter niet meer aan de orde, vandaar dat in dit artikel gebruik gemaakt gaat worden van het volledige Nec2 programma. Dit betekent niet dat in alle gevallen Nec2 de voorkeur geniet boven Mininec. In zeer speciale gevallen, zoals b.v. voor LF, kan Mininec soms betere resultaten geven. 

Met name in die gevallen, waarbij de invloed en eigenschappen van het aardoppervlak bij antennehoogtes van een kwart golflengte of lager in overweging moeten worden genomen is Nec2 sterk in het voordeel. Ook voor de hogere frequenties > 300Mhz levert Nec2 nauwkeuriger resultaten dan het standaard Mininec programma. Mininec is hiervoor in de loop der jaren wel aangepast, echter deze gewijzigde versies zijn alleen beschikbaar binnen de commercieel verkrijgbare programma’s.

Daar door het originele Nec2 slechts puur getalsmatige resultaten gegenereerd worden, wordt gebruik gemaakt van het programma 4nec2 dat deze informatie automatisch omzet naar voor de mens beter verteerbare grafische 3D antenne modellen, stralingsdiagrammen en b.v. SGV grafieken. Beide programma’s zijn als zgn. freeware, en dus gratis, beschikbare via het internet. (Zie einde artikel).

Dit programma is gedurende de afgelopen tien jaar ontstaan vanuit een simpel Qbasic experiment waarop in de loop der tijd diverse uitbreidingen en aanpassingen zijn doorgevoerd. Daar het mij wel leuk leek om het zo ontstane programma en de hiermee opgedane ervaringen te delen met anderen is dit artikel ontstaan.

Het eigenlijke Nec2 rekenprogramma (of engine) dient gevoed te worden met informatie over het betrokken model. Ook dit is getalsmatige/tekstuele informatie. 4nec2 bevat de mogelijkheid om dit middels een soort teken programma te doen. Dit beperkt echter enigszins de ruime mogelijkheden welke door (4)Nec2 worden geboden. Vandaar dat in dit artikel tevens ingegaan zal worden op ingave van een model door middel van een tekstverwerker. Binnen 4nec2 kan hieroor onder andere de standaard Windows Notepad tekstverwerker gebruikt worden.

Een model binnen Nec2 is opgebouwd uit lijnstukken of ‘wires’. Een loop antenne bijvoorbeeld wordt hierbij voorgesteld als een groot aantal korte lijstukken opgesteld in b.v. een cirkel, waarbij het eind van het voorgaande lijnstuk is verbonden met het begin van het volgende. Deze lijnstukken worden ook wel ‘elementen’ genoemd. In het volgende hoofdstuk (deel 1) wordt nader besproken hoe middels deze elementen een antenne model te maken.

Deel 1:  Schetsmatige model-ingave

In dit eerste deel zal beschreven worden hoe op relatief eenvoudige schetsmatige wijze een antenne model ingegeven kan worden binnen 4nec2, zonder dat men op de hoogte is van de methodiek die hiervoor binnen het eigenlijke nec2 rekenprogramma van toepassing is. Hierbij wordt maximaal gebruik gemaakt van het feit dat we op een Windows computersysteem met behulp van onze muis lijnen kunnen tekenen op het scherm. Voor diegenen die wel eens met een tekenpakket zoals b.v. ‘Paint’ hebben gewerkt zal een en ander niet onbekend voorkomen.

Dit heeft echter wel als nadeel, dat een op deze wijze gemodelleerde antenne niet zonder meer te optimaliseren is (zie bovenstaand artikel), omdat een en ander intern berekend en bepaald gaat worden en er zodoende niet met variabelen gewerkt kan worden.

Nadat de 4nec2 software geïnstalleerd is, zal standaard deze zogenaamde ‘Geometry editor’ (geometrie bewerker) ingesteld staan. Mocht dit onverhoopt niet het geval zijn, dan dient hiervoor ‘Settings->Geometry edit’ op het ‘Main’ venster te worden aangeklikt.

Zodra 4nec2 is opgestart en een willekeurig model is gekozen, kiezen we voor ‘Edit -> Input file’ op het ‘Main’ venster. Er zal nu een nieuw venster getoond worden met het zojuist geselecteerde model. 

Binnen dit venster zijn een aantal zaken te onderscheiden.

· De titelbalk. Dit is de bovenste gekleurde balk met de naam van ons model. 

· De menubalk. Hier zijn de verschillende functies en mogelijkheden te selecteren.

· Het tekenvlak. Dit is het witte vlak, waarin ons model wordt getekend of weergegeven.

· Het infoblok Dit is het blok rechtsboven op het scherm. Hier wordt aangegeven en ingesteld wat er getoond wordt en hoe het model getoond moet worden.

· De functieknoppen. Deze bevinden zich links en rechts boven het tekenvlak. 

· Met de linkse 4 knoppen wordt geven aan vanaf welke kant wij ons model willen bekijken. ruimtelijk (3D) of in het platte vlak (2D), en wel van voren, van opzij of van boven. Indien voor 3D wordt gekozen kan terwijl de linker muisknop ingedrukt wordt gehouden het model worden gedraaid. Wordt de rechter muisknop ingedrukt gehouden, dan wordt het model verschoven. Deze laatste mogelijkheid heeft men ook bij de 2D.

· De rechtse 7 ‘objecttype’ knoppen. Hiermee wordt aangegeven welke onderdelen van ons model we willen selecteren, wijzigen en/of toevoegen. We kennen de volgende objecttypes:
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Lijnstukken (wires) waaruit het model is/wordt opgebouwd.
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Voedingspunt, spannings/stroombronnen voor voeding van het model.
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Weerstand, spoelen, condensatoren, impedanties en materiaal eigenschappen.
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Transmissie lijnen (coax, open-lijn, stubs).
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Commentaar en overzicht lijnstukken/wires.
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Specificatie ontwerp frequentie.
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Specificatie aardoppervlak.

· De middelste 3 knoppen geven aan welke actie(s) we willen uitvoeren
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Selectie van specifieke objecten voor gekozen objecttype
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Toevoegen van nieuwe objecten voor gekozen objecttype
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Voor het verwijderen van een geselecteerd object

· Het datablok. Dit is het blok rechts onder op het scherm. Hierin worden de actuele gegevens getoond voor het geselecteerd object. Naast wijziging van een object door het selecteren en slepen met de muis, kunnen hier gegevens rechtstreeks gewijzigd worden. 

· Net boven het datablok is een schuifbalk opgenomen, waarmee door alle voorkomende objecten van het gekozen type kan worden gelopen.

Men kan een bepaald object selecteren door met de functieknoppen een bepaald type te kiezen en vervolgens binnen het tekenvlak met de linkermuisknop op het object te klikken.  Een geselecteerd object wordt rood en ‘dik’ weergegeven. Bevindt de muis zich op het object, dan wordt een dubbele pijl getoond ten teken dat het object met door drukken van de linker muisknop verplaatst kan worden. Ook kunnen nu met de rechter muisknop extra functies voor het object worden gekozen. Bij objecttype ‘Wire’ kan men ook meerdere lijnstukken tegelijk selecteren door met de rechtermuisknop een kader te trekken om de betrokken lijnstukken. 

Om te kunnen zien hoe een en ander werkt is het handig om een bestaand voorbeeld model te openen (File->Open) en eens te stoeien met een en ander. Let wel op dat u bij het afsluiten van het Venster of 4nec2 zelf niet het originele model overschrijft.

Ingave dipool model

Om een nieuw model te maken, selecteren we ‘File->New’. Het tekenvlak wordt gewist, en er wordt automatisch gekozen voor 2D weergave in het XZ vlak (X-as naar rechts, Z as naar boven, Y-as naar achteren). Het eerste wat ons te doen staat is opgeven voor welke frequentie ons model bedoeld is. Dit geven we op door in het datablok (midden rechts) achter ‘frequency’ de waarde 7.05 Mhz (gevolgd door <Tab>) op te geven.  De rasterverdeling (grid) wordt automatisch aangepast aan de gekozen frequentie zodat een halve golf ca 60% van het venster bedraagt.

We beginnen met het algemeen geaccepteerde basismodel, namelijk de dipool in de vrije ruimte (free space). Hiertoe selecteren we met de functieknoppen het objecttype ‘Wire’ gevolgd door ‘Add’ om aan te geven dat we willen gaan toevoegen.

Terwijl we met de muis binnen het tekenvlak bewegen, zien we de X(Y)Z coördinaten rechts op het scherm veranderen. Een dipool bestaat uit twee maal een kwart golflengte draad. Voor 40 meter kiezen we daarom met de muis als eerste uiteinde het punt XYZ = [-10, 0, 0]. Terwijl de linker muisknop ingedrukt wordt gehouden verplaatsen we de muis naar rechts naar het punt XYZ=[10, 0, 0]) en laten de muisknop los. Er wordt nu gevraagd om de draad diameter (Wire radius first element). Hier dient de straal (helft diameter) te worden opgegeven. We kiezen voor 1mm. Merk op dat elk uiteinde automatisch op het snijpunt van de roosterlijnen gepositioneerd wordt. Dit kan uit/aan-geschakeld worden door ‘Snap to grid’ te klikken.  De fijnheid van het rooster kan gewijzigd worden d.m.v. de ‘Grid’ schuifbalk.

Ons eerste en voor een dipool enige antenne-element is nu gedefinieerd. Vervolgens dienen we aan te geven waar de dipool gevoed wordt. Dit doen we door het objectype ‘voedingspunt’ te kiezen. We plaatsen de muis ergens binnen het tekenvlak, drukken de linker muisknop en slepen het voedingspunt symbool naar het midden van de dipool waar we de muisknop loslaten. 

Om te voorkomen dat onze wijzigingen per ongeluk verloren gaan kiezen we ‘Menu->Save as’ en slaan ons model op onder b.v. de naam ‘dipool1.nec’. 

We kunnen hierna b.v. de ingangsimpedantie en het stralingsdiagram laten berekenen door op het rekenmachine symbool te klikken of de <F7> toets te drukken. Binnen het ‘Generate’ venster kiezen we vervolgens voor ‘Far-field pattern’ en klikken op ‘Generate’. Binnen het ‘Pattern (F4)’ of ‘Geometry (F3)’ venster kan het stralingsdiagram of de stroomverdeling over onze dipool bekeken worden (probeer zelf de verschillende andere menukeuzes voor de beide vensters).

Een dipool in de vrije ruimte zal in de praktijk (in elk geval voor 40 meter) niet snel voorkomen. We zullen nu dan ook onze dipool opstellen boven een aardoppervlak en kijken welke de gevolgen hiervan zijn. We doen dit door binnen het ‘Geometry edit’ venster (<F6> toets) ons dipool element te selecteren. Zodra de dubbele pijl verschijnt drukken we de linker  muisknop en verschuiven onze dipool (binnen XZ vlak) naar een hoogte (Z) van 15 meter. Probeer hierbij de beide uiteinden op –10 en +10 meter te houden.

Hierna kiezen we voor het objecttype ‘Aardoppervlak’ en selecteren in het rechter (data-)

blok ‘Ground parameters’ allereerst het ‘ground’-type ‘SomNec’ ground. De term SomNec slaat op de rekenmethode die toegepast wordt om werkelijke eigenschappen van het aardoppervlak mee te nemen in het model. Vervolgens selecteren we gemiddelde eigenschappen door ‘Clay/forest (Average)’ te kiezen. We slaan nu ons nieuwe model op middels ‘File->Save as’ onder de naam ‘dipool2.nec’. Met <F7> en ‘Far-field pattern’ genereren we een nieuw stralingsdiagram. Andere gegevens hierbij laten we ongewijzigd.

Indien we het ‘Main’ venster raadplegen, zien we een ingangsimpedantie van  78.5 + j 57.4 ohm. Niet helemaal in resonantie dus. Hiervoor hebben we een lengte van 2 maal 10.37 meter nodig. Deze aanpassing doen we door opnieuw het dipool element te selecteren. In het blok rechts worden de XYZ coördinaten voor beide uiteinden (E1 en E2) weergegeven. We  passen nu handmatig voor beiden de Y coördinaat (middelste waarde) aan van (-)10 naar (-)10.37 meter. We slaan ons model op als ‘dipool2.nec’ en geven opnieuw <F7> met ‘far field pattern’. We zien nu een impedantie van 87.2 + j 0.5 ohm. Indien we binnen het ‘Geometry (F3)’ venster op het voedingspunt object klikken verschijnt een nieuw venster waarin een SWR (t.o.v. 50 ohm) van ca 1:1.75 wordt getoond. 

Deze berekende waardes kunnen iets afwijken afhankelijk van de instelling voor automatische segmentering welke voor uw systeem geldt. (Zie evt. Options->Segmentation)

Inverted-V model

Wat we nu gaan doen is vergelijken wat het effect is indien we onze dipool veranderen in een Inverted-V antenne. (Zie fig 1) 

[image: image1.jpg]


Dit doen we door opnieuw ons dipool antenne element te selecteren en zodra de dubbele pijl getoond wordt de rechter muisknop te drukken, waarna we ‘ Split wire’ kiezen. Hiermee gaan we ons enkele antenne element in twee gelijke stukken opsplitsen waarbij we de beide uiteinden gaan verschuiven tot ze onder een hoek van ca 45 graden naar beneden wijzen. Het voedingspunt object is nu iets verschoven naar het linker element, dit is echter in dit geval niet echt van belang.  

Figuur 1.

Het verschuiven doen we door eerst de linker dipool helft te selecteren en vervolgens met de muis naar het linker uiteinde te gaan totdat een kuis met 4 pijlpunten verschijnt. Nu drukken we de linker muisknop en verplaatsen het uiteinde naar rechts en beneden tot op de positie [0, -7.5, 7.5]. Ditzelfde doen we voor het rechteruiteinde van de rechter helft en plaatsen dit op [0, 7.5, 7.5].  Met behulp van de rechter muisknop, gevolgd door ‘Undo move’ kan men eventueel een laatste verplaatsing ongedaan maken. 

Om ons model exact in resonantie te brengen kunnen we handmatig beide coördinaten aanpassen naar respectievelijk [0,-7.5, 7.62] en [0, 7.5, 7.62]. Als alles goed is gegaan hebben we nu een inverted-V met twee naar beneden wijzende elementen. We slaan ons model op als ‘inverted1.nec’. Mocht e.e.a niet geheel goed verlopen zijn, dan kunnen we opnieuw ‘dipool2.nec’ inladen en een nieuwe poging wagen.

Met F7 en ‘Far-field pattern’ genereren we een nieuw stralingsdiagram. Binnen het ‘Pattern (F4)’ venster kan men door de pijltoetsen te bedienen het horizontale of verticale diagram voor verschillende op/afstralingshoeken bekijken. Met de spatiebalk kan gewisseld worden tussen het horizontale- of verticale diagram. Tevens zien we (klikken op voedingspunt in ‘Geometry (F2) venster) een impedantie van 54.7 + j 0.1 en een SWR van ca 1:1.1.

Om onze inverted-V met onze voorgaande dipool te vergelijken drukken we de ‘Insert’ toets of kiezen voor ‘Compare->Add pattern’ en selecteren vervolgens het dipool2.out bestand. Zowel het diagram voor de dipool als voor de inverted-V worden nu getoond. Door met de muis op een van de diagram lijnen te klikken, kunnen specifieke waardes bekeken worden, waarbij we zien dat er hooguit 1dB verschil is tussen beide antennes (voor bruikbare opstralingshoeken). Niet de moeite waard dus om voor een dipool twee hoge bevestigingspunten te zoeken, terwijl een inverted-V met één genoegen neemt.

Door ‘Options->View Nec2 data’ te kiezen kan bekeken worden hoe het overeenkomstige Nec2 ingangsbestand er uit komt te zien. Door nogmaals te klikken of een van de knoppen rechtsboven te kiezen keert men terug. Voor verdere mogelijkheden wordt men verwezen naar de 4nec help bestanden (4nec2.hlp, <F1> toets of 4nec2.rtf om uit te printen).

Deel 2: Tekstuele ingave

Een Nec2 ingangsbestand bestaat uit zogenaamde ‘Cards’. In gewoon Nederlands zijn dit regels in een tekstbestand. Elke card of regel begint met een twee letterige code welke de functie van de card beschrijft. Zo kennen we CM cards voor commentaar (ComMent) en GW cards voor beschrijving van de lijnstukken (Wire Geometry) waaruit ons model is opgebouwd. 

Elk lijnstuk/wire in ons model wordt gedefinieerd door een zogenaamd tag-nummer (tag= label/ etiket). Normaliter beginnen we met 1 en nummeren zo door. 
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Een lijnstuk is altijd opgebouwd uit een of meer segmenten die in elkaars verlengde liggen. Het aantal segmenten dient aan bepaalde voorwaarden te voldoen om een maximale nauwkeurigheid te bereiken. Normaliter moeten altijd 10 of meer segmenten per halve golflengte (in meters) worden gebruikt. Bevat een model veel (scherpe) hoeken, dan is het raadzaam dit aantal te verhogen tot 20 of soms zelfs 40. Dit gaat echter ten koste van de benodigde rekentijd.

Daarnaast wordt een lijnstuk gedefinieerd door een begin en eindpunt. Hiervoor wordt het XYZ coördinaten stelsel gebruikt. De X-as wijst hierbij naar rechts, de Y as naar achteren en de Z-as naar boven (zie fig. 2). Elk punt in de drie dimensionale ruimte kan beschreven worden middels een XYZ coördinaat. Deze coördinaten zijn in meters. 

                              Figuur 2

Als laatste wordt de radius (straal, helft van de diameter, in meters) opgegeven. Ook deze radius dient binnen bepaalde ruime grenzen te liggen. Een en ander afhankelijk van de frequentie, de segment-lengte en de radius van het aangrenzend element. 

Binnen 4nec2 wordt op het overgrote deel van deze eisen gecontroleerd. Bij fouten wordt U hierop automatisch geattendeerd.

Het dipool model

Het ingangsbestand voor een 40 meter dipool van 2*10 meter op een hoogte van 15 meter zou er als volgt uit kunnen zien:
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Een regel met een ‘ als eerste teken wordt door 4nec2 als extra commentaar beschouwd. Deze regels worden weggefilterd indien het bestand aan het eigenlijke Nec2 programma wordt aangeboden. De CM regels zijn ‘officieel’ Nec2 commentaar en mogen alleen aan het begin van het bestand voorkomen. Er mogen nul, een of meer CM regels worden opgenomen. Deze regels moeten altijd worden afgesloten met een ‘CE’ (Comment End) card. Ook hierachter mag extra tekst worden opgenomen.

Elke regel is opgebouwd uit een of meer velden, voorafgegaan door het card-type. Voor de GW cards wordt in het eerste veld het tag-nummer en in het tweede veld het aantal segmenten opgenomen. We hebben hiervoor een oneven aantal genomen omdat we zo een segment (11) hebben dat exact in het midden van de dipool ligt. In veld 3, 4 en 5 worden vervolgens de X, Y en Z coördinaten voor het beginpunt en in veld 6, 7 en 8 de coördinaten voor het eindpunt ingevuld. 

Voor x1 en x2 worden in dit voorbeeld de beide eindpunten voor de koperdraad waaruit de antenne is samengesteld opgenomen van respectievelijk –10 en +10 meter vanaf het midden opgegeven. Voor y1 en y1 wordt een 0 gegeven omdat ons model (nog) geen diepte kent. Voor z1 en z2 wordt een hoogte van 15 meter opgegeven. In het laatste veld wordt de ‘radius’ van het lijnstuk vermeld. In dit geval 1 mm.

Er kunnen een of meer GW regels worden opgenomen. De GW regels moeten altijd worden afgesloten met een GE card (Geometry End).

We hebben nu de geometrie voor een dipool ingegeven. Echter een en ander zal ook ergens gevoed moeten worden. Dit wordt gedaan door het opgeven van een EX card (ExcitatioN). Deze card is als volgt gedefinieerd.
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Hierbij wordt de dipool in het midden gevoed. Veld 2 (tagn) refereert hierbij naar de betrokken GW card, terwijl veld 3 (segn) aangeeft dat gevoed wordt in het midden van segment 11 van de uit 21 segmenten opgebouwde dipool. In Veld 5 (Vreal) wordt 1 (volt) opgegeven. In veld 6 (Vimag) een nul, zodat geen extra faseverschuiving van toepassing is. Veld 5 en 6 bepalen in principe het aan de antenne toegevoerde vermogen. Later in dit artikel komen we hierop terug.

Nog niet bekend is nu echter voor welk frekwentie een en ander dient te worden doorgerekend. Dit wordt opgegeven door een FR card (FRequency) toe te voegen. Deze card is als volgt opgebouwd
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‘ Frekwentie

Het eerste, derde en vierde veld zijn voor normaal gebruik gevuld met nul. Het tweede veld geeft het aantal frequenties aan waarvoor alles moet worden doorgerekend, terwijl het vijfde veld de (start)frekwentie aangeeft. Optioneel kan in het zesde veld een stapgrootte worden opgevuld.

Als laatste dient een EN card (ENd) te worden opgegeven. Hiermee wordt het einde van een Nec2 model gedefinieerd. (Binnen een Nec2 bestand kunnen namelijk meerdere door te rekenen modellen worden opgegeven). Een en ander komt er nu als volgt uit te zien.
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Voor diegenen die 4nec2 hebben gedownload en geïnstalleerd wordt het nu tijd om de ‘Notepad’ tekstverwerker op te starten en bovengenoemde tekstregels over te nemen. Tussen de verschillende velden wordt een <Tab> opgegeven. Vervolgens dient een en ander te worden weggeschreven in uw ..\4nec2\models folder onder b.v. de naam ‘TEST.NEC’.

Hierna kan 4nec2 worden gestart en het TEST.NEC bestand worden geselecteerd. Indien alles goed is ingegeven zal het model in het ‘Geometry’ venster worden getoond. Middels de muis of de pijltoetsen kan het model worden gedraaid en/of verschoven.

Voor diegenen die geïnteresseerd zijn in de overige mogelijkheden met betrekking tot de Nec2 cards wordt verwezen naar de Nec2 documentatie. Zie hiervoor de referentie als opgenomen aan het eind van dit artikel.

n.b. Door ‘Edit’ gevolgd door ‘Input (.nec) file’ te selecteren of de <F6> toets te drukken kan men rechtstreeks de ‘Notepad’ editor voor het actuele model opstarten. Hiervoor dient wel even gecontroleerd te worden of in het ‘Settings’ menu, ‘Notepad edit’ is aangevinkt.

Doorrekenen

Om het model te laten doorrekenen kan ‘Calculate’ gevolgd door ‘generate nec-2 output data’ worden gegeven of de <F7> functietoets kan worden gedrukt. Er verschijnt nu een nieuw venster

Genaamd ‘Generate’. Hier dient ‘Use original file’ te worden geselecteerd, waarna <Enter> kan worden gegeven of op [Generate] kan worden geklikt.

Er verschijnt nu kortstondig een zwart venster, waarin het eigenlijke Nec2 programma wordt gestart. Zodra de berekening beëindigd is verdwijnt het weer en worden de resultaten door 4nec2 ingelezen en getoond. 

In het ‘Main (F2)’ venster zal nu b.v. achter ‘Impedance’ de ingangsweerstand (65 + J 54) voor het betrokken model worden getoond. Tevens wordt de ingangsspanning voor een vermogen van 100 Watt en de hierbij behorende antenne stroom weergegeven. Het gewenste vermogen kan eventueel gewijzigd worden door ‘Settings -> Input power’ te selecteren. (-> betekend: ‘gevolgd door’)

Het is mogelijk dat afhankelijk van uw beeldschermgrootte het venster gedeeltelijk buiten het scherm valt. Door met de muis op het bovenste deel van het venster te klikken kan dit verschoven worden. De nieuwe positie blijft binnen 4nec2 bewaard. Ook kan de grootte van het venster aangepast worden door op de randen van het venster te klikken en deze te verplaatsen.

Binnen het ‘Geometry (F3)’ venster kan door ‘Show->Current magn.’ te selecteren  de verdeling van de stroom over onze dipool beken worden (zie fig. 2). Door ergens op de dipool ‘wire’ te klikken kan bekeken worden welk segment het betreft en welke de stroom door dit segment is. Door een X te toetsen kan gewisseld worden tussen polaire of ‘rechthoek’ notatie. Indien op het voedingspunt wordt geklikt (rode cirkel) wordt tevens de ingangsimpedantie en SGV getoond. 

De lezer wordt aangemoedigd de overige mogelijkheden binnen het ‘Show’ menu uit te proberen. De ‘Validate’ functie zal geen fouten opleveren daar het hier gebruikte model geen fouten zou mogen bevatten. Ook de ‘View’ en ‘Wire/Segm’ menu’s kunnen uitgeprobeerd worden.

Het stralingsdiagram

De ongeduldige lezer zal zich nu afvragen, hoe zit het nu met het stralingsdiagram. Hiervoor dienen we opnieuw de functie ‘Generate->generate nec2 output data’ te selecteren (F7 toets). Echter vervolgens selecteren we de optie ‘Far field pattern’. Onder in het venster verschijnen nu extra ingave velden. Hierbij kiezen we voor een volledig diagram door ‘Full’ kiezen en een resolutie van 5 graden (degrees). De overige velden laten we ongewijzigd. Na <Enter> of [Generate] wordt een en ander doorgerekend en verschijnt in een nieuw venster genaamd ‘Pattern (F4)’ het stralingsdiagram in de vrije ruimte voor een dipool.

Ook in het ‘Geometry (F3)’ venster kan men het diagram laten tonen door hier ‘Show->Near/Far field’ te selecteren of de ‘R’ toets te drukken. Wat hierbij opvalt is dat door nec2 het stralingsdiagram altijd ten opzichte van de oorsprong van het coördinatenstelsel wordt berekend (en getoond). 

Het stralingsdiagram voor een dipool in de vrije ruimte is op zich echter weinig interessant. Hierin wordt tegemoetgekomen door een aardoppervlak aan ons model toe te voegen. Let op !, Voordat we hier echter mee starten, dienen we een standaard 4nec2 instelling te wijzigen. Selecteer hiervoor ‘Settings’ in het ‘Main’ venster en selecteer ‘Notepad edit’.

Wijziging van een ingelezen model geschiedt vervolgens door ‘Edit->Input (.nec) file’ te selecteren in het ‘Main (F2)’ venster of door de <F6> toets te drukken. De Notepad tekstverwerker wordt gestart en het TEST.NEC model wordt ingeladen.

We voegen nu tussen de FR en de EN card, de volgende regel toe.

GN
1


‘ Perfect ground.

Hiermee hebben we een perfect geleidend aardoppervlak gedefinieerd. Sla het bestand op en sluit de tekstverwerker en genereer vervolgens een stralingsdiagram op de wijze als hierboven beschreven. 
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                             Figuur 3                                                                   Figuur 4

Er zal nu een gewijzigd diagram verschijnen waarbij het merendeel van de straling schuin naar boven is gericht. Met ‘Show->Structure’ in het ‘Pattern’ venster kan binnen het diagram de geometrie structuur worden weergegeven.

Met de pijltoetsen kan men vervolgens het diagram van verschillende kanten (Phi angle) bekijken. Door op de spatiebalk te drukken wisselt men van het verticale- naar het horizontale diagram en omgekeerd. Indien in het ‘Geometry (F3)’ venster de functie ‘Show->near/far field geselecteerd was, kan tegelijkertijd in 3D bekeken worden welke ‘doorsnede’ in het ‘Pattern (F4)’ venster getoond wordt. (Zie fig-3 en 4)

Er wordt maximale versterking behaald van 6.8 dBi. We zien dat dit plaatsheeft voor een opstralingshoek Theta van 40 graden en voor een hoek in het horizontale vlak Phi van 90 graden. De hier gebruikte termen Theta en Phi zijn de standaard kreten zoals deze binnen Nec2 gebruikt worden. Over het algemeen echter zal de gemiddelde gebruiker liever werken met de termen ‘Azimut’ en ‘Elevatie’.  De hoekaanduidingen in graden hiervoor werken net de ander kant op. Door middel van ‘Settings->Phi/Azim unit’ kan men wisselen van Theta/Phi naar Elevatie/Azimut presentatie en omgekeerd. 

In de praktijk echter zal niemand kunnen beschikken over een perfect geleidende aarde voor HF. We wijzigen dan ook middels de <F6> toets (Edit) de GN card voor ons model op volgende wijze:

‘
Type



Diel
Cond

GN
2
0
0
0
13
.005

‘ Real ground

Hiermee geven we in het type door een 2 op te geven aan dat we een echt aardoppervlak willen simuleren (dit gebeurt binnen Nec2 middels de Sommerfeld-Norton methode). Hierbij dienen we zowel de diëlectrische constante (Diel) als de geleidbaarheid (Cond) op te geven. We hebben in dit geval gemiddelde waarden genomen. Voor andere ‘soorten’ aarde en de hier bijbehorende gegevens wordt men verwezen naar het 4nec2 help bestand.

Wanneer we het 4nec2 ingangsbestand sluiten en opslaan en vervolgens opnieuw het stralingsdiagram laten doorrekenen zien we dat e.e.a opnieuw gewijzigd is. Wat opvalt is dat nu de opstralingshoek iets gezakt is en er nu in verhouding meer vermogen wordt uitgestraald voor de lagere opstralingshoeken, hoewel de maximale versterking hiervoor is gezakt tot 6.15 dBi. De ingangsimpedantie bedraagt 78.5 + J 57.3 ohm. (SGV voor 50 ohm=1: 2.67)

Andere mogelijkheden

Voor diegenen die willen uitproberen welke de invloed is van verschillende antenne materialen is de LD card (LoaDing) beschikbaar. Hiervoor geldt de volgende opmaak:

‘
type
tagn
first
last
cond

LD
5
0
0
0
58000000
‘ Hele model van koper.

Als type wordt hier 5 gebruikt wat wil zeggen dat de geleidbaarheid van het materiaal willen specificeren, waaruit de elementen/wires binnen ons model zijn samengesteld. Indien voor het tweede veld ‘Tag’ nummer een 0 wordt ingegeven betekend dit dat de beschrijving van toepassing is op alle elementen/wires binnen het model. Indien gewenst kunnen verschillende geleidbaarheden worden opgegeven door meerdere LD 5 regels voor verschillende Tag-nummers op te nemen. Wel moeten bijbehorende GW regels aanwezig zijn. De gegeven geleidbaarheid van 58000000 Siemens (mho/m) komt overeen met die van koper. Geleidbaarheden voor andere materialen zijn opgenomen in het 4nec2 help bestand. 

Daarnaast heeft men de mogelijkheid om in grafiekvorm te bekijken welke het verloop van de ingangsimpedantie, SGV, versterking, en/of voor-achter verhouding is voor het betrokken model over een bepaald frequentiebereik. Kies hiervoor de optie ‘Use frequency loop’ gevolgd door ‘Gain’ in het ‘Generate’ scherm (<F7> toets).  Hierbij wordt gevraagd om de start- en stop frequentie en een stapgrootte. Deze stapgrootte bepaald het aantal berekeningen dat wordt uitgevoerd. Achter ‘Forward’ dient de Theta/Phi of Elevatie/Azimut hoek ingevuld te worden waarvoor men de Gain/versterking berekend wil zien.

Wordt de optie ‘Ver’ of ‘Hor’ geselecteerd, dan kan men na afloop van de berekeningen in het ‘Pattern (F4)’ venster met de linker en rechter pijltoetsen het verticale of horizontale stralingsdiagram bekijken als berekend voor de verschillende frequenties. Hierbij dient de gewenste theta/elevatie of phi/azimut hoek opgegeven te worden.
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Diegenen die de moeite genomen hebben om de 4nec2X versie te installeren kunnen de <F9> toets gebruiken om het model en het diagram in ‘real-time’ 3D formaat te aanschouwen. Hierbij worden moderne grafische technieken toegepast. Een voorbeeld hiervan voor een 40 meter quad is in figuur 5 gegeven.

Figuur 5

Nec-2 edit

Via de hierboven beschreven tekstuele methode voor model-ingave of aanpassing (en ook middels de reeds aan het begin van het artikel genoemde ‘teken’ methode) is een grote verscheidenheid aan antenne modellen te definiëren. Bij 4nec2 zijn een groot aantal voorbeelden van simpel tot zeer complex opgenomen welke als uitgangspunt kunnen dienen voor het opstellen van een eigen model.

Naast beide genoemde methodes is een derde methode beschikbaar, en wel via ‘Nec-2 edit’. Het betreft hierbij een alternatief soort tekstverwerker, waarbij per regel (nadat het Card type is geselecteerd) automatisch wordt aangegeven welke velden voor het betrokken card-type kunnen worden opgegeven. Op deze wijze wordt de gebruiker enigszins begeleid bij ingave van de Nec-2 card regels. Middels het ‘Settings’ menu op het ‘Main (F2)’ venster kan men omschakelen tussen de verschillende methodes voor modelingave.

Antenne optimalisatie

Men zal zich nu wellicht afvragen waarom al dat gedoe met die Nec2 cards, terwijl we ook op relatief eenvoudige wijze het model op een schetsmatige manier kunnen tekenen. Dit alles heeft te maken met de wijze waarop we ons antenne model automatisch door de computer kunnen laten optimaliseren. 

Binnen 4nec2 staan hiervoor twee automatische methoden ter beschikking. De standaard  methode is de zogenaamde ‘hill-climbing’ methode. Hierbij wordt eerst een bepaalde antenne eigenschap (b.v. de draadlengte) een klein beetje veranderd. Gekeken wordt of dit een positief of negatieve uitwerking heeft op b.v. de staande golf verhouding. Bij negatieve uitwerking (grotere SGV) wordt vervolgens de aanpassing de andere kant op gedaan. Hierna wordt de draadlengte in meerdere stappen zo lang aangepast, waarbij de SGV steeds dichter bij 1:1 komt, totdat deze weer slechter wordt doordat de lengte te lang (of te kort) wordt. De stapgrootte wordt nu verkleind en van richting veranderd waarbij de lengte in stappen wordt verminderd, totdat opnieuw de optimale lengte gepasseerd wordt. Dit gebeurt zo een aantal malen heen en weer terug totdat besloten wordt dat een verdere verkleining van de stapgrootte geen zin meer heeft. De draadlengte is nu aangepast voor een optimale SGV. 

De andere methode is gebaseerd op genetische principes, zoals deze ook door de natuur toegepast worden in het natuurlijk selectieproces. Het voert in het kader van dit artikel echter te ver om hier nader op in te gaan. Bij voldoende belangstelling kan hier natuurlijk een volgend artikel aan gewijd worden.

Beide methodes werken met zogenaamde symbolen of variabelen. Hiermee wordt een bepaalde fysieke eigenschap van de antenne, zoals b.v. in ons voorbeeld de draadlengte, beschreven. Hiervoor wordt de (alleen binnen 4nec2 toegepaste) SY card gebruikt. Hiermee definiëren we een variabele naam en de bijbehorende waarde. Vervolgens nemen we onze variabele op binnen een of meer GW of andere Cards. In ons TEST.NEC voorbeeld vervangen we (via Notepad) de GW regel door de volgende twee regels: (-10 en 10 zijn hier vervangen door respectievelijk ‘-len’ en ‘len’, terwijl de Z-waarde (hoogte) van 15 (meter) vervangen is door de variabele ‘hoog’)

SY len = 10, hoog = 15

GW
1
21
-len
0
hoog
len
0
hoog
0.001

Het complete model (zonder veld commentaar) wordt als volgt

CM 40 meter dipool op 15 meter hoogte
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Bij de definitie van symbolen en ook op andere plekken binnen het bestand waar symbolen gebruikt worden kunnen diverse rekenkundige bewerkingen op deze symbolen worden opgenomen zoals optellen aftrekken, vermenigvuldigen e.d. en functies zoals sinus, cosinus, logaritme e.d. Een uitgebreid en reeds geoptimaliseerd voorbeeld hiervan is het bestand 

“3-el-inverted-V.nec” dat opgenomen is bij het 4nec2 programma.

Nadat ons nieuwe model is gewijzigd en opgeslagen kiezen we ‘Calculate->Optimize nec2 input data’ in het ‘Main (F2)’ venster of drukken op de <F12> functietoets. Er verschijnt nu een geheel nieuw venster genaamd ‘Optimizer and evaluator’. In eerste instantie schrikt men wellicht van de hoeveelheid velden en informatie binnen dit venster. In de meeste gevallen echter hoeft maar weinig ingegeven te worden. 

Hoe en Wat

Een van de belangrijkste vragen bij optimalisatie is de vraag welke HF en/of elektrische eigenschap van het model men wil optimaliseren. Het antwoord hierop wordt ingegeven door middel van de zeven velden onder ‘Weighting factors (FOM) in %’ (weegfactoren, FOM=Figure Of Merit, vertaling ??).

Op een of meer van de volgende eigenschappen kan geoptimaliseerd worden:

SWR
Staande golf verhouding tov gedefinieerde Z0 (Zie Settings).

Gain
Forward gain in dBi voor gespecificeerde opstralingshoek.

F/B
Voor-achter verhouding voor gespecificeerde opstralingshoek(en)

F/R
Idem voor ‘Front to Rear’ verhouding

Ra
Reële deel antenne ingangsimpedantie

Xa
Complexe deel antenne ingangsimpedantie

Eff
Verhouding tussen verliezen en uitgestraald vermogen.

SWR, Ra en Xa worden standaard geminimaliseerd. Gain, F/B, F/R en Eff worden standaard gemaximaliseerd. Door met de rechter muisknop op een van de betrokken velden te klikken kan hier van worden afgeweken.

In dit specifieke voorbeeld willen we een zodanige draadlengte bereiken dat onze dipool in resonantie is voor 7.05 Mhz. Dit doen we door het complexe deel van de ingangsimpedantie (naar nul) te optimaliseren. Hiertoe zorgen we ervoor dat alleen in het veld ‘X-a’ een waarde van ‘100’ (%) is ingevuld (intypen of met linker muisknop op velden klikken, waarbij tussen 0 en 100 gewisseld wordt). Zorg er voor dat voor alle overige 6 velden een waarde van 0 is opgegeven.

Daarnaast is het van belang welke fysieke antenne eigenschap we willen veranderen om het gewenste resultaat te verkrijgen. Dit hadden we al enigszins voorbereid door in ons model de variabelen ‘len’ en ‘hoog’ op te nemen. Deze variabele vinden we terug in het veld onder de kop ‘Variables’. We selecteren alleen de variabele ‘len’ door hier met de linker muisknop op te klikken. De variabele zal nu worden toegevoegd aan de kolom onder de kop ‘selected’. Door nogmaals te klikken kunnen we een geselecteerde variabele weer verwijderen. De variabele ‘hoog’ dient niet geselecteerd te zijn, omdat we alleen de lengte willen variëren.

Hiermee zijn alle voorbereidingen gedaan en kunnen we het optimalisatieproces starten door op ‘Start’ te klikken.  Er verschijnt nu een zandloper terwijl keer op keer het model wordt doorgerekend met telkens een andere waarde voor de draadlengte ‘len’. Na een tiental seconden verschijnt de melding ‘Optimized in XX steps, YY sec.’ ten teken dat e.e.a. gereed is. Klik op OK.

(Afhankelijk van specifieke instellingen zijn ongeveer 28 stappen benodigd)
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In het veld onder de kop ‘variable values’ kan bekeken worden op welke wijze de lengte gewijzigd is. Dit doet men door op een waarde te klikken en met de pijltoetsen hier doorheen te lopen. In het veld onder ‘Calculated results’ kan bekeken worden welke resultaten er bij een bepaalde lengte horen. De uiteindelijke lengte voor resonantie blijkt te zijn uitgekomen op 10.37 meter. De ingansimpedantie is hiervoor ca 87 ohm. De SGV voor 50 ohm is hiermee teruggebracht van 1:2.6 naar 1:1.7 (Zie ook fig-6)

                                             Figuur 6

Is men tevreden met het resultaat, dan kan men op [Save results] klikken om de nieuwe lengte te laten verwerken in het TEST.NEC ingangsbestand. In ons voorbeeld doen we dit en we sluiten vervolgens het venster door op [Exit] te klikken.

Indien we nu vervolgens het ingangsbestand openen middels <F6>, dan zien we dat de waarde voor de variabele ‘len’  is aangepast volgens het laatste optimalisatie resultaat. Als we vervolgens een nieuw stralingsdiagram laten berekenen zien we dat de versterking ongeveer gelijk is gebleven (6.18 dBi)

Om de inverted-V als genoemd in de volgende paragraaf voor resonantie te optimaliseren is uitgegaan van het volgende model. (alleen de eerste regels zijn gegeven de rest is ongewijzigd).

CM 40 meter inverted-V 

CE

SY len=7.5, hoog=15, delta=7.5

SY end=hoog-delta

GW
1
21
0.0
-len
end
0.0
0.0
hoog
0.001

GW
2
21
0.0
0.0
hoog
0.0
len
end
0.001

GE

etc.

Zowel de variabele ‘len’ als ‘delta’ kan opgegeven worden om de draadlengte te optimaliseren voor resonantie.
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Het hierbovenstaande is slechts een enkel simpel voorbeeld van wat met simulatie en optimalisatie van antenne modellen te bereiken is. Voor de echte liefhebber is het, doordat bij het dipool model ook de hoogte als variabele is opgenomen, met het gegeven model mogelijk om een optimale hoogte te bepalen voor een bepaalde gewenste opstralingshoek. Hiervoor dient de waarde in het ‘X-a’ veld op nul gesteld te worden terwijl voor ‘Gain’ in dit geval 100% mag worden ingevuld. We zien nu dat de onder ‘Gain’ opgenomen velden nu ook ingevuld mogen worden. Alleen de bovenste linker twee velden zijn hierbij van belang. Hier dient de gewenste opstralingshoek en de hoofdrichting van het stralingsdiagram in het horizontale vlak te worden ingegeven. Over het algemeen voldoet een resolutie van 5 graden ruimschoots.

                            Figuur 7                                                                          Figuur 8            

Tot zover deze introductie in antenne modelering. Naast de hier beschreven mogelijkheden zijn er nog diverse andere zaken met (4)nec2 mogelijk zoals:

· Specificatie van het materiaal waaruit (onderdelen) van ons model zijn opgebouwd. Deze zullen verliezen introduceren in ons model.

· Opnemen van spoelen, condenstoren of ‘traps’ in ons model. B.v. voor een multiband antenne.

· Specificatie van stroombronnen als voeding. Dit om meerdere (verticale) elementen met een bepaald faseverschil te voeden.

· Frequentieafhankelijkheid voor b.v. Z-in, SWR, F/B etc. (Zie fig 7 en 8)

· Laten berekenen en tonen van de veldsterkte E en H voor het nabije veld. Dit kan van belang zijn bij risicoanalyse zoals b.v. door de duitse en amerikaanse overheid verplicht is gesteld voor amateurstations.

· Automatische generatie van antenne input-files voor gebruik bij propagatie voorspellingen door middel van de ItsHF software (eveneens gratis, zie einde artikel).

· Gebruik van zgn. surface patches om gelijdende vlakken te modeleren. B.v. reflectors voor VHF/UHF antennes.

-
En meer.., zie hiervoor de 4nec2.hlp, 4nec2.rtf en/of de _Gettingstarted.txt file.

Verwijzigingen:

4nec2 (inclusief Nec2 engines)

www.qsl.net/wb6tpu/swindex.html
Officiële Nec2 documentatie

www.nec2.org
Extra achtergrond informatie

www.cebik.com
Propagatie voorspellling


http://elberts.its.bldrdoc.gov/hf.html
